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1. Server Installation and Activation

1 Installation and Deployment

Edraw Authorization Server V 2.4.10 comes with advanced Docker
technology, which simplifies the installation process and eliminates the impact
of environmental differences on the servers.

It also has built-in mechanisms such as automatic service activity checks
and the ability to troubleshoot problems.

It is strongly recommended to deploy this authorization server to Linux
operating systems.

1.1 Linux Operating System

Linux server recommended configuration:
— Hardware: 4-core CPU, 2G memory, 50G hard disk (SSD recommended)

- Software: CentOS 7.8, Docker -CE 20.10+
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1.1.1.X86 Architecture

Edraw Server Docker image download link:
https://www.edrawsoft.cn/2download/edserver/edrawserver- 2.4.10 .tar

The Linux system image download/import and start container
commands are as follows:

REPOSITORY TAG IMAGE ID CREATED SIZE

docker.edrawsoft.cn/version/edrawserver 2.4.10 bbe8dec8db8b About a minute ago 112MB
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1.1.2.ARM architecture

Edraw Server Docker image download link:
https://www.edrawsoft.cn/2download/edserver/edrawserver-2.4.10-arm .tar

The Linux system image download/import and start container
commands are as follows:

REPOSITORY IMAGE ID CREATED
SIZE

docker.edrawsoft.cn/version/edrawserver 2.4.10-arm bbe8dec8db8b About a minute ago 112MB
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1.1.2.1.Command Description

1. “Data directory”, contains license-related information, which needs to be

back-up regularly;

2. “Download Mirror”, if the License included is able to access the Internet,
you may directly use the wget command to download the image file. If you
are unable to access it, please manually copy the file to the Linux server;

3. “Import image”, after importing the image, you will be able to see the
image that was just imported through the “docker images” command. It
should be available at docker.edrawsoft.cn/version/edrawserver:2.4.10

4. “Start container”

a) -d

b) --name edrawserver

c) --restart always

d) --privileged
e) -e TCP_SERVER_ADDR

f) -e EDRAW_HTTP_BASE_URL

g) -p 80:80
h) -p 8915:8915

i) -v$(pwd)/data:/app/data

) -v $(pwd)/log:/app/log

The container is running in the
background

The name of the container is
edrawserver

Start this container as soon

as the docker service starts

Extends permissions to the container
Provides the address of the
authorization service for the client
Management interface, automatic
upgrade package download address
Web service working port number
Client authorization service port
number

Store data in the data folder under
the current directory

Store logs in the log folder under the

current directory

k) After launching, you can use the command “docker ps” to view a

container named “edrawserver”

Page5

https://www.edrawsoft.com/business.html



"W

wondershare

=) edraw

1.2 Windows Operating System

Edraw Server Zip package download link:
https://www.edrawsoft.cn/2download/edserver/edrawserver-2.4.10.zip

Installation Steps:

1. Download the Zip package and unzip it to the local disk. It is
recommended to install it in the root directory of the drive, and there
should be no spaces in the path, for example: C :\EdrawServer

2. Configure the environment variables TCP_SERVER_ADDR (client
connection address, that is, the address where the client is able to
access the server), EDRAW_HTTP_BASE_URL (the path to access the
server, http://address). If the server address is 192.168.57.2, the
configuration example is as follows:

Systern variables

Variable Value &3

PROCESSOR_REVISION 3c03
PSModulePath ProgramFiles %\ WindowsPowerShell\Meodules; C\Windows'syste...
192.168.57.2

TCP_SERVER_ADDR

System variables

Variable Value &3

ChWindows\System 32\ Drivers\DriverData
hitp://192.168.57.2/

DriverData
EDRAW _HTTP_BASE_URL

3. Use "Explorer” to open the folder where the program is located. Right-click "
Register_Start.bat ", and select “Run as administrator”. (You also need to
“‘Run as administrator” for Stop_Uninstall.bat).

Local Disk (C:) » EdrawSerser w | 0 Search E
Mame Date modified
bin 8/10/2022 1:48 PM
config 8/10/2022 1:48 PM
public 8/10,/2022 1:48 PM
[ edraw-service 310/2022 1:48 PM
Register_Star Open
Stop_Uninsta Edit
Print

® Run as administrator
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4. After installation is successful, it will be registered as a system service (It
will run in the background and the system will start automatically once it
launches), and automatically open the browser to jump to the system page

thereafter.

EN C\Windows\System32icmd.exe

nerate config file ekt

ontime . . .

5. In the "Services" tab of "Task Manager", you can see that EdrawServer

has been registered as a system service

=+ Task Manager
File Options View
Processes Performance App history Startup Users Details Services

7

Mame PID Description
Eaphost Extensible Authentication Protocol
edgeupdate Microsoft Edge Update Service (edg...
edgeupdatem Microsoft Edge Update Service (edg...
EdrawServer 9736 Edraw License Server
EFS Encrypting File System (EFS)
Page7
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2 Initial Activation

You are required to add a license to the Edraw Server before it can
provide authorization services for client software such as Edraw Mind
Map, Edraw Icon, and Edraw Project Management.

After the container is started, you will see the login page through
http:/ip}/. Use admin/12345678 to log in to the system, and the
"Authorization Activation" window will pop up thereafter.

Dedraw Edraw Server
Account:

Password:

Authorize and Activate

Feature Code:456E-5EFB-3F76-6703-FCB6-63EA-5849-201C

License Code
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Click on the [Copy] button to copy the “feature code” and send it to the
customer service staff to obtain the “authorization code”. Paste it into the
“authorization code” text box and click the [Activate] button to complete the
initial activation.

Edraw Server Client Activation Address: 192.168.200.254 B O=omin
Overview

Device Management

Upgrades

Config

Authorize and Activate

About Feature Code:456E-5EFB-3F76-6703-FCB6-63EA-5849-201C

License Code:| 24F738091CD6578BEFB81C941 FBACE2F BSECECOB2ZA0001 4C2306AFF 645CEROF 0
FAE190D954065F 1601626 7AE2695CD1F 2095885905 25B5BCEEC 40B34 9DEF 0E03
B6FES3294FA279730567CIEOFF 3FFA435D05F 281 41 B3R 599808581 ZE1EACA9E0
6CDEFF 788C8886C3C2BAR 1584E4389E 72C0D1 5A054068C29461 0CACRO0BAASF 5
01049E7DD291C49E 64577011 6EDF 52651 DEF 9ED4B0EACBBE44CT 411 2CF 044 1CE

Edraw Server Client Activation Address: 192.168.200.251 @ Oacmin

71| Wondershare Wondershare Wondershare
EdrawMind EdrawMax EdrawProj
Device Management . X X
Devices Devices Devices
Upgrades 0 O O O 0 0
Configuration
Active Inactive Active Inactive Active Inactive
About
Remaining Remaining Remaining
10 10 10
Remaining Remaining Remaining
0 0 0 10 0 10
Expiration Date: 2022/12/31 Expiration Date: 2022/12/31 Expiration Date: 2022/12/31
Edraw Server Client Activation Address: 192.168.200.251 @ @amin
Overview
Device Management Dedraw Edraw Server (v2.4.13)

Upgrades .
Authorized to: *** Company

Configuration
Authorized Products:

About EdrawMind 10 users (2022/08/09 - 2022/12/31)
EdrawMax 10 users (2022/08/09 - 2022/12/31)
EdrawProj 10 users (2022/08/09 - 2022/12/31)

Copyright © 2022 Edrawsoft. All rights reserved
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3 Password Change

Hover the mouse over [admin] in the upper right corner and click the pop-up
menu [Change Password]. Enter your old password, followed by your new

password. Repeat your new password, and then click OK.

Edraw Server Client Activation Address: 192.168.200.251 @ @aomin

Change Password

Overview

Dedraw Edraw Server (v2.4.13)

Device Management

Upgrades
Authorized to:  *** Company

Configuration
Authorized Products:

About EdrawMind 10 users (2022/08/09 - 2022/12/31)
EdrawMax 10 users (2022/08/09 - 2022/12/31)
EdrawProj 10 users (2022/08/09 - 2022/12/31)

Copyright © 2022 Edrawsoft. All rights reserved.

Edraw Server *Company  Client Activation Address: 192.168.200.251 @ Oamin

Overview

Dedraw Edraw Server (v2.4.13)

Device Management

Upgrades

Authorized to:  *** Company

Configuration x

Auth
Change Password

(2022/08/09 - 2022/12/31)

Edrav
Edrav (2022/08/09 - 2022/12/31)

n

ights reserved.
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4 Update Authorization

When the license is changed, you may click the [Update License Information]
button on the [About] page, and the subsequent operations will be the same as
the initial activation.

5 Disable/Enable the Client

Due to some unforeseen circumstances, it may be necessary to disable the
registered client to release the license that was initially used for the client.

To do this, open the [User Information] interface, where the list of registered
clients will be shown.

The query conditions will be divided into two groups according to "Disabled”
and "Enabled" status. Enter the search content in the box to match the three
fields of job number, name, and host name at the same time.

When the number of registered users is too high, fuzzy queries will occupy more
computing resources. It is recommended to use "precise query" instead in this
case, as it meets most application scenarios.

If you find a client in the "Enabled" state, you may click the [Disable] button to
revoke their access, and a prompt will appear when the client logs in again to
inform them that their access has been disabled; if you wish to provide access
again to users in the "Disabled" status, you may click the [Enable] button to
reinstate their access to the server.

Edraw Server Client Activation Address: 192.168.13.22:8915 @ ©aamin
) d EdrawMind g EdrawMax EdrawProj
Overview
® Enabled Disabled ® Exact Match Fuzzy Lookup
Device Management
Upgrades User ID User Name 0S Type Category Language Version Host Name Status Manage
40bit@® yangyq windows common multi 9.0.13 Win102021P... Inactive Disable
Configuration s = 3 2 2
40bit yangyq windows common multi 9.0:11 Win102021P... Inactive Disable
2 2 windows common multi 9.0.12 SZ19063341.. Inactive Disable
About
2 2 windows common multi 9.0.13 SZ19063341.. Inactive Disable
ubuntu ubuntu ubuntu common multi 9.0.14 huhc-virtual-...  Inactive Disable
1234556 yangyq 0sx common multi 9.0.12 iMac.local Inactive Disable
centos centos centos common multi 9.0.14 localhost.loc... Inactive Disable
Mac Mac osx common multi 9.0.12 SZ19063341.. Inactive Disable
Total & terms/page, Display 20 terms/page < [{l} > Go to page
Pagell
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6 Export Client Information

You may export all client information stored in the product by clicking on the
[Export csv] button. It is recommended to use WPS or a newer version of
Excel to open the file to avoid the problem of character set mismatch in the
document.

&2 Edraw Server Client Activation Address: 192.168.13.22:8915

» "4 || Wondershare o Wondershare Wondershare
| EdrawMind EdrawMax EdrawProj

¢ Enabled Disabled

Overview

Device Management

Upgrades User ID User Name 0S Type Category Language
40bit® yangyq windows common multi
Configuration ; ’ .
40bit yangyq windows commaon multi
About 2 2 windows common multi
2 2 windows common multi
ubuntu ubuntu ubuntu common multi
1234556 yangyq 0sX common multi
centos centos centos common multi
Mac Mac 0sX common multi

Total 8 terms/page, Display 20 terms/page <

B3 Master-20220811-...c5v A
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7 Client Automatic Upgrade

As the Edraw series software continues to upgrade interactively, in order to
reduce the burden on administrators, the client versions after EdrawMax
11.1.3 and MindMaster 9.0.8 will support automatic update checks.

After the authorization server updates the new version information, the user
will be prompted to upgrade and confirm the update automatically. The
administrator will then obtain the upgrade package (in zip format).

Click on the [Upload ] button on the [Upgrade Management ]page to
complete the upgrade package update. You may also click the [Delete]
button to delete the upgrade package on the server.

Note:

1. Upgrading packages of the same category will retain only the last version
of the server;

2. In order to avoid network congestion caused by a large number of

user downloads, the server only allows 40 concurrent downloads by
default.

Edraw Server Client Activation Address: 192.168.13.22:8915 @ ©min

— Instructions:
verview

1. The installation package is identified by four types of information: product, OS type, subclass, and language.
Device Management 2. For the same type of installation package, the server only keeps the last uploaded version

3. Only when the client with the upgrade function completely matches the four types of information will it be
automatically installed the latest version or prompted to update.

Upgries 4. You can choose to upload multiple installation packages at a time, but the total size cannot exceed 500M

Configuration

Product 0S Type Subclass Language  Version Installation Package
About
Pro windows common o 235 edrawproj_2.3.5_intranet.exe

Master windows common multi 9.0.13 mindmaster-9.0.13-multi-binnerexe
Max windows common a 1152 EdrawMax 11.52_cn innerexe
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8 Broadcast Messages

The system reserves a broadcast message interface for broadcasting
messages to Edraw software users. Fill in the [Global Configuration]
[Broadcast Message] and the user will be prompted with this message the
next time they open the server.

9 Server Migration

When the authorization server needs to be migrated, the address of the new
server can be set on the old server, and the client will automatically switch to
the new server after startup.

Edraw Server Client Activation Address: 192.168.13.22:8915 @ O-:0min

Overview Notification: (After configuration, a prompt message will pop up when a user starts software m

Device Management

Upgrades P

Configuration

Server transfer: (After configuration, the authorization server address will be updated when a user m
° I
About starts software again.)

[ | For example: 192.168.1.1:8915; edrawserver.company.com: 8915

Pagel4
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2. Client Product Activation

Take EdrawMax as an example to show the client product activation.

1. Activate with server

After installing the EdrawMax client, double-click the shortcut created on the
desktop to start EdrawMax. An activation request will pop up automatically
when you open it for the first time.

L Recent
* Recommended

“e Personal Templates

*  Basic

¢ Business
Business Management
Quality Management
Project Management
Strategy and Planning
Marketing

Analysis Canvas

«'  Network

! Engineering

»  Software & Database >

EdrawMax (Unlicensed Version)

Recommended
E] Activate from Server ®
<-E
Fill in the server address and port number:
Server Address:
Basic Flowchart
Port: 8915
Name:
ID:
b
=
g 8
Activation steps: File-> Account->Activate from Server
Do not show this message again.
UML Modeling
]
- \/
> e
Basic Electrical Gantt Charts Chen ERD

[

|l
\.\
e

Mind Map
|
|

Floor Plan

Process P&ID

After the activation request appears, fill in the IP address, port, name and job
number of the server to activate the product. (Note: the name and job number
may be left blank, the default is "-").

For example: the server IP and port information are IP: 1 0.10.7.162 port: 8
915. Please fill in the information in the position where the activation prompt
pops up on the EdrawMax client.

Pagel5
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Search diagrams..

L Recent
* Recommended

“e Personal Templates

*  Basic

€ Business
Business Management
Quality Management
Project Management
Strategy and Planning
Marketing

Analysis Canvas

Account i Network

Options ! Engineering

% Software & Database ~

EdrawMax (Unlicensed Version)

Recommended

Activate from Server

Fill in the server address and port number:

Server Address:  192.168.200.254)
Port: 2915

Name:

D:

Activate

Activation steps: File-> Account->Activate from Server
Do not show this message again.

A —

Basic Electrical Gantt Charts

Basic Flowchart

UML Modeling

\ /
e

Chen ERD

Mind Map
|
|

Floor Plan

Process P&ID

After filling in the IP address and port information, click on the “Activate”

button below, and a prompt will appear if the activation is successful. Please
restart EdrawMax to start using it.

Search diagrams...

- Recent
* Recommended

@ Personal Templates

*  Basic

¢ Business
Business Management
Quality Management
Project Management
Strategy and Planning
Marketing

Analysis Canvas

“' Network

Options

! Engineering

If the activation fails, the following prompt will appear.

4> Software & Database >

EdrawMax

Recommended

[E] Activate from Server

Fill in the server address and port number:

Server Adi

Port: X
a EdrawMax activated!

Mame:

D: 0K

Activation steps: File->Account-> Activate from Server
Do not show this message again.

] _

Basic Electrical Gantt Charts

Basic Flowchart

UML Modeling

A4

e

Chen ERD

¢

e/
)\

-
Mind Map
|
|

Floor Plan

Process P&ID

Should this happen to you, please contact IT or the server administrator to
confirm whether the IP and port information are correct and whether the
service has been started successfully.
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Search diagrams..

“  Recent
* Recommended

® Personal Templates

*  Basic

¢  Business
Business Management
Quality Management
Project Management
Strategy and Planning
Marketing

Analysis Canvas

% Network

! Engineering

4 Software & Database »

EdrawMax (Unlicensed Version)

Recommended

[E] Activate from Server X

Fill in the server address and port number:

Activate X
Basic Flowchart
Failed to connect to the server!
Please fill in the correct server address and port number.

0K -

[ ]
Activation steps: File-> Account-» Activate from Server
Do not show this message again.

UML Modeling
—
. N/
L 3 —
e
Basic Electrical Gantt Charts Chen ERD

\am!
)\

L J
Mind Map
|
|

Floor Plan

Process P&ID

If activation had been skipped during startup, you may use the Activation
function under the Help function bar in the EdrawMax function page to

activate the product.

Account

Activate from Server

Activate with Mobile
Phone

% T

About Check for Updates

2. Activate with your phone:

For customers who are unable to build an intranet authentication server, the

o
‘

mobile phone QR code activation method serves as an alternative for intranet

activation.

Click on the [Help] menu of the software, and then click [Activation] — [Phone

Activation].
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